MSU Cognos Enterprise Planning
Raise Process for Non Union and Union Professional and Supervisory Staff

August/September, 2017

Denice Beckwith- OPB
Rebecca Hallisy- HR Operations
Agenda

- Overview of Raise Process
  - Key Dates
  - Salary Increases
  - Cognos Raise Model
  - Determining Eligibility
  - Control Total
  - Reconciling Data Affecting Control Totals
  - Enforcement of Minimum Salaries
  - Merit Pay Strategy
  - Supervisor Review of Data
  - Special Increases
  - HR Review of Data
  - Raise Notifications
  - New Raise Report

- Overview of Raise Model Functionality
### 2017-18 Professional Staff Raise Process Schedule
Revised 7/19/2017

<table>
<thead>
<tr>
<th>Dates</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wednesday, August 30</td>
<td>Professional staff data <strong>LOADED</strong> into raise application.</td>
</tr>
<tr>
<td>Tuesday, September 5</td>
<td>Professional staff raise process <strong>available</strong> online; Units may <strong>ENTER</strong> raises online (about 3 weeks). HR to reconcile raise data twice a week and contact MAUs with changes while raise model is open.</td>
</tr>
<tr>
<td>Friday, September 22 (MAU Deadline)</td>
<td>Raise process <strong>CLOSES</strong>; Electronic approval <strong>COMPLETED</strong>.</td>
</tr>
<tr>
<td></td>
<td>Please see communication from your MAU on internal deadlines.</td>
</tr>
<tr>
<td>Monday, September 25 through Thursday, September 28</td>
<td>Raise files <strong>REVIEWED</strong> by Human Resources for processing.</td>
</tr>
<tr>
<td>Friday, September 29 through Wednesday, October 11</td>
<td>Raises <strong>LOADED</strong> into the HR/Payroll System, including manual corrections.</td>
</tr>
<tr>
<td>Friday, October 13</td>
<td>Raise notifications <strong>AVAILABLE</strong> electronically via BI report per MAU/Department security access to MAUs for distribution.</td>
</tr>
</tbody>
</table>
The Coalition of Labor Organizations at Michigan State University (MSU) negotiates base salary increases for union staff*

- 2017-2018 raise cycle (1.9%)

Each individual contract determines the distribution of this base percent

- APA = 40/60 split or .76% General and 1.14% Merit
- APSA = 25/75 split or .475% General and 1.425% Merit

Non-union staff are given a merit pool of an equal percent to the union agreement

Salary increases are effective October 1, 2017

*Note: Increases are dependent on health care costs
Cognos Raise Model

- Application used to designate annual merit raise recommendations
- Data organized by MAU, then organizational units
- Employees appear in their home employing unit list
- Information in the raise model is based off of September 30, 2017 data
- Personnel actions that have not been processed by September 1, 2017 are not reflected in the raise model as of the opening date.
Cognos Raise Model, Cont’d

- Raise model contains
  - Personnel number
  - Continuous Employment Date
  - Job Name
  - Employment Percent
  - Organizational Unit
  - Annual Salary
  - Leave Status
  - Supervisor
  - Pay Grade Level
  - Pay Grade Minimum
Determining Eligibility

- HR provides standard criteria to determine whether an employee is eligible to be included in the raise process

- For eligibility criteria, refer to Chapter 2 in the Raise Process Resource Guide
Control Totals

- A calculated control total is provided by unit and by MAU for all salary increases
- Control totals are based off annual salaries and are grouped by:
  - APA Union
  - APSA Union
  - APA/APSA Non-Union
  - Nurses
- Dynamically calculated based on values entered
- Control totals cannot be shared across groups
- The MAU must use the full calculated control total for each group; Human Resources will not accept any final submissions until merit raise amounts are met and not exceeded for each group
- Individual units may exceed or fall short of this number as determined by the actual raise given
Reconciling Data Changes Affecting Control Totals

- While the raise model is open, HR will reconcile changes to employee records in the HR/Payroll system with data in the Cognos raise model. **Occurs every Monday and Wednesday morning.**

- Changes to raise model with updated data will occur after 5:00 p.m. on Monday and Wednesday. Org units affected will be emailed the following day, alerting them to changes.

- When the raise model is closed, HR will continue to manually balance totals until raise data is loaded in the HR-Payroll System. Balancing after that point is done on an as-needed basis.
Enforcement of Minimum Salaries

After the raise has been applied, MSU HR will analyze salaries to ensure that salaries meet the minimum pay ranges. Those individuals whose FTE salary falls short of the minimum range, will automatically be adjusted to the minimum.
Merit Pay Strategy

- Part of your unit’s compensation philosophy and overall strategy to reward staff.

- What’s not new:
  - Clear goals and objectives
  - Documented accomplishments
  - Evaluations are completed timely
  - No surprises for the employee
  - Not used for equity or market adjustments
  - Intended to reward higher performers
Don’t forget:

- This can be a good time to extend informal recognition.
  - Personal notes or letters is a best practice for the extra touch. Be timely. Be specific.
- Prepare to have conversations prior to the form letter from HR for those not getting “full merit”.
- Staff should know how merit is determined for your MAU/department.
Example Utilizing Dollar amount

1. Divide total amount of money by number of employees
2. This gives an average per employee
3. Higher performers get more than lower performers.
4. Can also utilize percentages in a similar fashion.

Example:
- Control total: $5000
- Employees 100
- $ per employee $50
- Middles get $50
- Lowers get $25
- Higher get $75
- Do not exceed the total
Supervisor Review of Raise Data

- Per the Administrative Professional Association contract letter of agreement on Merit Pay guidelines, supervisors are to determine, approve and communicate merit increases to their employees
  
  - Supervisor information is provided in the Cognos raise model for this purpose
  - Each supervisor should be provided a hard copy of the final raise for the employee to review and sign
  - A copy of this signature should be kept in the department’s personnel file for no less than one year
  - The supervisor should discuss this Merit increase with the employee prior to the distribution of raise notifications

- If the supervisor information in the raise model is incorrect please correct it for next year using the ‘Maintain Reporting Relationships’ tool on the ‘Unit Administrators’ tab of the EBS Portal
Optional Special Increases

- Space has been provided in the raise model for departments to enter an additional optional increase referred to as a Special Increase.

- Takes the place of any additional raise departments would have entered separately outside of the general and/or merit increase process.

- No control total is provided for this increase and the department is expected to fully fund this increase independent of the annual raise process.

- Will be effective October 1 of the raise year just like the general and/or merit increase.
Requirements for Special Increases

1. Departments must complete and attach a Special Increase Supporting Documentation Form in the raise model for each employee receiving the optional special increase

2. Regardless of the method to obtain the form, it must be completed, signed, scanned, and attached in the raise model for the applicable employee

3. Each form will be reviewed by Human Resources first, regardless of increase amount entered, prior to entering the raise in the HR/Payroll System
Location of Support Staff Special Increase Supporting Documentation

https://www.hr.msu.edu/ua/recognition/support-staff/documents/SpecialIncreasesSSEmps.pdf
HR Review of Raise Data

- After raises have been submitted HR identifies any changes to the data and manually adjusts salaries accordingly

- HR updates data into the HR/Payroll System using mass raise tools
Raise Notifications

- Raise letters are generated for each employee that receives a salary increase
- Raise letters are provided in the form of a report under Business Intelligence
- Raise letters contain the new annual salary rate effective October 1, 2017 as of the day the letter is generated
- The salary is expressed as a rounded amount to be paid
Raise Letters

1. Located under Business Intelligence and Analytics

Public Folders > HR-Payroll Folder > University HR-Payroll Reports > HR Unit Reporting Admin and Manager Self Service Reports > HR Unit Reporting Administrator Reports

2. Requires the HR Unit Reporting Admin role
Raise Report

Public Folders > Budget Folder > University Budget Reports > Raise Process > Professional Raise Report-DRAFT-ROI002

• This report details the raise data submitted by MAUs before input in the SAP system. This is preliminary data which is subject to further review.

• Prompts include: fiscal year, professional employee groups, supervisor, organization.

• The following format is shown in this professional raise report for organization(s) or supervisor selection within the prompt page:
  1. Summary totals
  2. Listing of all employees for organizations selected
  3. Listing of employees for each organization selected
## Raise Report

**Summary of Raise Data for Organization(s) Selected on Prompt Page**

### University Organization Code: 10000000 - UNIVERSITY

<table>
<thead>
<tr>
<th>Raise Group</th>
<th>Annual Salary</th>
<th>General Increase Amount</th>
<th>Merit Amount to Distribute</th>
<th>Merit Amount</th>
<th>MERIT NOT YET DISTRIBUTED</th>
<th>Optional Special Increase Amount</th>
<th>Recommended Salary Amount</th>
<th>Recommended Raise Increase Percent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Union APA</td>
<td>$70,050.00</td>
<td>$560.40</td>
<td>$840.60</td>
<td>$889.60</td>
<td>($49.00)</td>
<td>0.00</td>
<td>$71,500.00</td>
<td>2.07%</td>
</tr>
<tr>
<td>Union APSA</td>
<td>$90,000.00</td>
<td>$450.00</td>
<td>$1,350.00</td>
<td>$1,350.00</td>
<td>0.00</td>
<td>0.00</td>
<td>$91,500.00</td>
<td>2.00%</td>
</tr>
<tr>
<td><strong>Total for University: - 10000000 - UNIVERSITY</strong></td>
<td>$160,050.00</td>
<td>$1,010.40</td>
<td>$2,190.60</td>
<td>$2,239.60</td>
<td>($49.00)</td>
<td>0.00</td>
<td>$163,300.00</td>
<td>2.03%</td>
</tr>
</tbody>
</table>

### Raise Data for Organization(s) Selected on Prompt Page

### Unit Level 1 Organization Code: 10050454 - OFFICE OF PLANNING AND BUDGETS

<table>
<thead>
<tr>
<th>Personnel Number</th>
<th>Person Name</th>
<th>Job Title</th>
<th>Supervisor</th>
<th>Leave</th>
<th>FE Percent</th>
<th>Raise Group</th>
<th>Eligible for Raise</th>
<th>Annual Salary</th>
<th>General Increase Amount</th>
<th>Merit Amount</th>
<th>Optional Special Increase Amount</th>
<th>Recommended Salary Amount</th>
<th>Recommended Raise Increase Percent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brent Johnston</td>
<td></td>
<td></td>
<td>No</td>
<td>100.00%</td>
<td></td>
<td>Union APA</td>
<td>Yes</td>
<td>$70,050.00</td>
<td>$560.40</td>
<td>$889.60</td>
<td>$0.00</td>
<td>$71,500.00</td>
<td>2.07%</td>
</tr>
<tr>
<td>Brent Johnston</td>
<td></td>
<td></td>
<td>No</td>
<td>100.00%</td>
<td></td>
<td>Union APSA</td>
<td>Yes</td>
<td>$90,000.00</td>
<td>$450.00</td>
<td>$1,350.00</td>
<td>0.00</td>
<td>$91,500.00</td>
<td>2.00%</td>
</tr>
<tr>
<td><strong>Total for Unit Level 1 Organization Code: 10050454 - OFFICE OF PLANNING AND BUDGETS</strong></td>
<td>$160,050.00</td>
<td>$1,010.40</td>
<td>$2,239.60</td>
<td>0.00</td>
<td>$163,300.00</td>
<td>2.03%</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Questions?

Installation

- Instructions for loading the Cognos Contributor Web Client is available on the Budget Planning and analysis web page.
- The URL for the installation procedure is: https://opb.msu.edu/functions/budget/Cognos.html
- This is a one-time load placing the web client on your computer.
Path to Raise Allocation Application within Portal

Enter the URL for the Cognos EP site:

https://ep.ebsp.msu.edu/cognos/

or log in through the EBS website (ebs.msu.edu) and click on the “Planning & Budgets” tile

Public Folder > Cognos Planning > Applications > - MSU > MSU Raise Process > MSU R03 Professional Raise
Roles in Cognos EP for Raise Process Application

Security access is controlled by the “RP” roles in D6501:

- **Cognos EP Viewer** – users get “view only” rights in system.

- **Cognos EP Submitter** – users may view, edit and save changes, and submit data for their organization(s) for central approval.
Access to the applications is determined by the security roles granted within D6501.

The following is the path to the ARM form for requesting access to applications in Cognos EP:

http://aissecuritycontact.ais.msu.edu/arms/index-ebs.html
Roles in Cognos EP for Raise Process Application

Security Groups for Raise Process

The *same* role is used for Professional and Faculty raise processes.

Example of raise security roles:

/group/EBSP/EP/10002000-RP-SUBMIT
or
/group/EBSP/EP/10002030-RP-VIEW
Resource Guides

The resource guide for the raise applications are available on the Planning and Budgets web page

http://opb.msu.edu/budget/cognos_planning/
Cognos Professional Raise Model

- **Rate Assumptions Prof**
  - Raise percentages for each employee grouping located here.

- **Raise Allocation Prof**
  - Merit and other raises entered here.

- **Raise Consolidation Prof**
  - Tracks available and remaining raise funding.
Workflow in Contributor

Select an organization and a table will appear on the right side of the screen.

Select an organization within the “Which is made up of” section of the screen. This opens the application.
Simplified Workflow in Contributor

Single Org User
Those users that have access to a single organization will show a workflow screen something like the image above.

Select an organization within the “You are a contributor for” section of the screen. This opens the application.
# Contributor - Workflow Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Not Started Icon](image) | **Not started**  
No changes have been saved to the data, although the contribution may have been opened for editing. |
| ![Work In Progress Icon](image) | **Work in progress**  
The data was saved but not submitted. You can change and submit data in this state. |
| ![Locked Icon](image) | **Locked**  
The data was submitted and the e.List item was locked. Data in this state is read only. If an e.List item is rejected, its state returns to Work in progress. |
| ![Incomplete Icon](image) | **Incomplete**  
At least one item belonging to this item is **Not started**, and at least one other item is in a state of **Work in progress**, **Locked**, or **Ready**. Data in this state was aggregated. The **Incomplete** state applies only to review e.List items. |
| ![Ready Icon](image) | **Ready**  
All e.List items belonging to the reviewer e.List item are locked. The data is ready to be submitted to the next level in the hierarchy. |
| ![Currently Being Edited or Annotated Icon](image) | **Currently being edited or annotated**  
The e.List item was opened for editing or annotating. Users end an edit session by closing the grid or by submitting the e.List item. |
| ![Out of Date Icon](image) | **Out of date**  
Data in the e.List item needs restructuring to reflect changes in the application, or system data must be imported. |
| ![Out of Date Icon](image) | Currently being edited or annotated and is out of date |
Raise Allocation – Workspace

Parts of Contributor Workspace

The Contributor workspace contains the following parts:

- **Tabs** – a separate tab represents each cube in the application
- **Dimension Bar** – shows the dimensions that are in the rows, columns, and context
- **Dimensions** – groups of related data, such as MAUs, employee data, fiscal year, etc.
- **Grid** – where you add or edit data
- **Grab Handles** – where a dimension or tab can be “grabbed” to move it within the grid
Contributor – Workspace

Parts of Contributor Workspace

Raise Allocation application in the Contributor workspace contains the following tabs:

- **Summary Tabs** – gray background as read-only data
- **Input Tab** – white background as contains fields for entering data
- **Assumption Tab** – used for calculations
## Contributor - Task Icons

<table>
<thead>
<tr>
<th>Task Icon</th>
<th>Task Description</th>
</tr>
</thead>
</table>
| ![Icon](image) | **Take Ownership**  
Users can access and modify the entries they own. |
| ![Icon](image) | **Add Commentary**  
Notes can be added to a plan. This is done by annotating a cell, a tab, or the whole model. Also notes can be attached to any cell regardless of its format. This is particularly useful for providing additional information regarding a particular cell. |
| ![Icon](image) | **Browse Commentary and Documents**  
Allows owner to view documents, edit comments and delete comments. |
| ![Icon](image) | **Swap Rows and Columns**  
Swaps the rows and columns that currently appear in the view. |
| ![Icon](image) | **Suppress Zeros**  
Hides blank rows and columns that contain all zeros. |
| ![Icon](image) | **Auto size Visible Range**  
Adjusts the rows and columns so that all the data is visible. |
| ![Icon](image) | **Submit**  
If you are happy with all the contents, submit from either the workflow screen or from the grid by clicking the submit button. |
| ![Icon](image) | **Reject**  
If you are not happy with the contents, and you have appropriate rights, you can reject, either from the workflow screen, or from the grid by clicking the reject button. Rejecting changes workflow from Locked to Work in Progress. It must be modified and resubmitted. |
| ![Icon](image) | **Validate**  
Verifies that the data entries or changes conform to existing business rules. |
| ![Icon](image) | **Help**  
Contributor documentation is available online by clicking the help button. |
| ![Icon](image) | **Note**  
Data that you can edit has a white background. Read-only data has a pale gray background. If you are not the current owner, the data opens in a read-only view. |
Changes to the Workspace

- The next time you open the same application your settings are retained.
- You can change your view by doing the following actions:
  - Move tabs
  - Freeze a pane
  - Hide rows and columns
  - Sort dimensions
  - Reposition dimensions
  - Total on Top?
Help Text

- A brief text message that appears at the bottom of the tab. Instructions can be different for every screen.
- Also, help text will appear as a light bulb icon within column headings or rows.
- Information about location of professional special increase template within either “Help” or “?”.
Reset Workspace View

To revert back to the default grid or tab views, select Reset Tabs only, Reset Grid only, or Reset both Tabs and Grid from the View menu by selecting Reset Views.

View > Reset Views > Reset both Tabs and Grids
Contributor – Attachments

- Attach comments and documents within the model, tabs, and cells
- View comments and attachments in the Commentary Browser

**Note:** If a raise amount is entered in the “OPTIONAL Special Increase $” column, then justification needs to be attached.
Raise Allocation Tabs

**Raise Consolidation Professional**

<table>
<thead>
<tr>
<th></th>
<th>Union APA</th>
<th>Union APSA</th>
<th>Non Union APA and APSA</th>
<th>Nurse</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Annual Base Salary</strong></td>
<td>531,293.41</td>
<td>613,172.04</td>
<td>786,638.94</td>
<td>656,621.48</td>
</tr>
<tr>
<td><strong>TOTAL Distributed Salary Increases</strong></td>
<td>7,234.35</td>
<td>3,065.86</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>GENERAL Increase $ Amount</strong></td>
<td>4,250.35</td>
<td>3,065.86</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>MERIT Raise Dollars to Distribute</strong></td>
<td>6,375.52</td>
<td>9,197.58</td>
<td>15,732.78</td>
<td>13,132.43</td>
</tr>
<tr>
<td><strong>MERIT Raise Dollars Distributed</strong></td>
<td>1,984.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>MERIT Raise Dollars Not Yet Distributed</strong></td>
<td>4,391.52</td>
<td>9,197.58</td>
<td>15,732.78</td>
<td>13,132.43</td>
</tr>
<tr>
<td><strong>OPTIONAL Special Increase $ Amount</strong></td>
<td>1,000.00</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Includes
- Annual Base Salary
- General Increase Amounts
- Merit Increases amount to distribute
- Merit Increases given
- Merit dollars remaining
Raise Allocation Tabs

Enter data within **white** background cells

<table>
<thead>
<tr>
<th>Person Name</th>
<th>Personnel Number</th>
<th>Merit Eligible?</th>
<th>Merit Raise %</th>
<th>Merit Raise $</th>
<th>Actual Merit Raise Given</th>
<th>Optional Special Increase %</th>
<th>Optional Special Increase $</th>
<th>New Base Salary Increase %</th>
<th>New Base Salary</th>
</tr>
</thead>
<tbody>
<tr>
<td>Person 1</td>
<td>4010</td>
<td>No</td>
<td></td>
<td></td>
<td>$720.00</td>
<td></td>
<td></td>
<td>0.80%</td>
<td>$60,480.00</td>
</tr>
<tr>
<td>Person 2</td>
<td>4011</td>
<td>Yes</td>
<td></td>
<td></td>
<td>$741.60</td>
<td>$742.00</td>
<td>1.62%</td>
<td>$1,000.00</td>
<td>3.62%</td>
</tr>
</tbody>
</table>

Includes

- Employee data
- Indicator if eligible for raise
- General Increases given
- Recommended MERIT Raise
- New Base Salary
Raise Allocation Tabs

Includes

- Listing of raise percentages by employee group
- Used to generate raise amounts in the allocation tab
Validate Data

If you enter a value in a cell that is outside the bounds of the rule, a warning message is shown when you attempt to submit or save the plan. You must correct the data before you can submit.

- If you get a warning message, in the Validation Error dialog box, click the error to view its location in the grid.
- The cursor goes to the first offending cell of the first failed rule.
Contributor – Validations

Raise Allocation Prof Tab

- If "No" is indicated in "Merit Eligible?" column, then MERIT RAISE amount must be ZERO.

- If a raise amount has been entered within "OPTIONAL Special Increase $" column then do the following:
  1. SELECT “See Attachment" within "Insert JUSTIFICATION for OPTIONAL Special Increase" column.
  2. INSERT justification documentation within the same cell.
Contributor – Validations

Raise Consolidation Prof Tab

- Raise control figures for the merit increase must be **fully used at the MAU level**.
- Total raise dollars given at the UNIT level may be greater or less than the control.
- A hard stop **has not been entered** in the model, but MERIT control totals are to be adhered to closely at the MAU level.
- Human Resources will be reviewing all MAU control totals. They will not accept any final submissions until MERIT raise amounts are met and not exceeded.
Printing from Excel

Quick Load to Excel

- You can quickly export the data in the active tab to Excel.
- To access the quick export, from the File menu select Export, then Quick Export or right-click in the grid and select Quick Export from the context menu.
- Excel opens with the data from the current tab.

Recommend suppressing zero rows before selecting Quick Export
Submit Data

- Submit the raise plan to the next reviewer in the application hierarchy when you are happy with the data it contains.
- Submitted items are locked and no further changes to the data can be done.
- Reviewers can either accept or reject the changes.
- When all raise plans within an MAU have been submitted, the ready workflow icon appears (green).
- When the MAU raise plan is submitted to the Human Resources Office, a locked workflow icon appears (locked).

Steps to Submit

Click the Submit icon (lock).
Reject Data

- If you are not happy with the contents, and you have appropriate rights, you can reject it, either from the workflow screen, or from the grid by clicking the reject icon (Reject).

- The reject changes the workflow from Locked to Work in Progress. The raise plan then must be modified and resubmitted.

Steps to Reject

Click the Reject icon (Reject).
Summary

- Professional raise process begins **Tuesday, September 5**.
- Raise control figures for the merit increase must be **fully used at the MAU level**.
- Justification document is required if a raise increment entered with “OPTIONAL Special Increase $” column.
- Resetting views within the Raise Allocation Prof tab may be helpful to assist in printing Union APA employee’s data for the required physical signature.
- Professional raise process closes on **Friday, September 22**.

**REMEMBER – Save Often and Take Ownership to Enter Data**
Contacts

Human Resources (Eligibility and Raise Entry/Processing)
Rebecca Hallisy
hallisy@msu.edu
884-0115

Office of Planning and Budgets (Cognos Raise Application Functionality)
Denice Beckwith
beckwi37@msu.edu
353-0864